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[m]I Geometry construction from mesh

Several tools added inside GID allow the geometry

creation (NURBS surfaces) from mesh data (triangles
or quadrilaterals).

Specially useful when:

* Input data for the simulation is discrete
e Scanners
* Images processing
 Visualization (render) meshes

* Optimization loops (usually, in each iteration, the
shape actualization is applied to the mesh) =
CIM.qNE“‘
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» Option to create one single NURBS surface from a mesh



[IEI Create NURBS patches from mesh

e Example of geometry generation from a mesh.

1.Input mesh
2.Sharp edges

detection and creation
of NURBS lines

3.Creation of NURBS surfaces

From a skin mesh, a subdivision of geometric entities (NURBS) it's \
automatically obtained which defines the same shape in a smooth way. = &
CIMNE?®



Join surfaces

Option to join NURBS surfaces: GID reconstructs a
new NURBS surface using the common boundary
of the surfaces to be joined.
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Join surfaces

* New surface can be created from a collection of
two or more connected surfaces

i

Reconstruction of 1 single surface is also possible by selecting
only one surface

/ Sote s
CIMNE®




[Imr Other news in geometry field

 Rhinoceros 4.0 export

« Import of x y z? ASCII files as points or nodes
* Import of ply format

 Boolean operations with multiple selection

* Improvements in geometric intersection
operations.

* Tcl wrapper of the HDF5 library to read/write this
data format.

« Parasolid format import updated from version
16004 to 20000

i N
CIMNE?
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| i) Boundary Layd} ENES

Preferences

User defined parameters: | o s e [fows e o o

Surface mesher
(%) RFast () RrSurf ) RIump

Bukomatic correck sizes

Three possible stretching functions: | " &t =

Unstructured size bransitions

. - 5 ) 0y .
*Function 1: Geometric | L]

Regular transition near boundary

hi =l ho .(r_o +l"1+r2 —|—'°'—|—ri_l) Structured mesh

[] Allow autamatic struckured

Symmetg

wlﬂ triangles [ tetrahedN
Boundary Laver Mesh

Stretching function: |[EETT T8 B ET=TT =T

*Function 2: Exponential

*  Grow factor |20 il

[

i, Boundary laver mesh in separated Layer
h — e(ri+in()) [ Boundary lay ; v

: Dthers
W = /

o Mesh until end
*Function 3:

Mo mesh frozen lavers

[] awoid elements with all its nodes in boundary

h h (1 = (l (1 ) . )) (] Maxirmumn chordal error in model (%3 | 10.0
B = . 1 r r)-i
> e i s o Mesh always by default o | ° i "-;.:

ficcept ] [ Reset ] [ Close o —
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[m]I 3D Boundary Layer Meshes

HOW tO aSS|gn boundary Iayer mESheS prOpertleS Boundary Layer Mesh
to entities Grow Law  Geometric
Grows Factor 210
bill GiD x64 Project: UNNAMED )
Files ‘iew Geometry LUtilities Data Mesh Calculate  Help
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[IIm 3D Boundary Layer Meshes

Example of a Boundary Layer Mesh in a wing profile
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3D Boundary Layer Meshes

(C]

Example of a Boundary Layer Mesh in a ship hull

bil

Plane cut of the mesh

Gi



) hew Unstructured volume mesher

User can choose now between three different
unstructured tetrahedral volume meshers:
« Based in Advancing front algorithm
- Based in Delaunay method

« Based in Isosurface Stuffing algorithm (F. Labelle and J.
Shewchuck) — Not constrained

Preferences

General | Graphical Meshing | Exchange | Fonts | Format | Grid

Cuadratic type J
(#) Mormal ) Quadratic () Quadratic?

Unstructured mesher

Sur‘fac -y o f?": Lo b :'\1umH

<- Yolume: (%) advancing front () Delaunay () Isosurface \>
T mesrabiconrre- L sizes 1
) Mone () Normal () Hard
Unstructured size transitions
0B &)
1 * -
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surface Stuffing based mesher

Main characteristics:
* Fast mesh generation
* Robust

* Able to generate a volume mesh from a bad quality
surface mesh

* Able to generate volume mesh from non conformal
surface mesh (available soon)

« Use of points lattices to improve tetrahedra quality
(good dihedral angles)

* Not constrained: it don’t give conformal meshes if

there are volumes sharing some surface
M

CIMNE®



lsosurface Stuffing bj%sed mesher

Steps of the mesher:

1. Generate ot 2. Generat L0 A'x‘
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Isosurface Stuffing based mesher

Very useful when the input geometrical model is in .stl format.

z

bl » bl

stl format ———>  Cartesian meshing ——» l€trahedral subdivision

and nodes move %ﬁt

\
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Quad-dominant meshes

Quad-dominant unstructured meshes can be generated
(mixed meshes with quadrilateral and triangles).

Preferences =

General | Graphical Meshing l Exchange | Fonts | Farmat | Grid |

CQuadratic tvpe

(&) Narmal (O Quadratic ) Quadratica

Unstructured mesher

Surface: O RFast (&) Rsurf O RIump

“olume: & Advancing front ) Delaunay () Isosurface
Aukomatic carreck sizes

() Mane (%) Mormal ) Hard
Unstructured size transitions

L7
Y
L7
S
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Regular transition near boundary

Structured mesh
[ Allaw autamatic struckured

Symmetrical structured; [v] triangles [v] tetrahedra

Boundary Laver Mesh

Stretching function: |Fun|:tiun 1 (Geometric) ¥  Grow factar; |2 jl

=

[] Boundary laver mesh in separated Layver
Chordal error
[[] Maximum chordal error in model, relative (32): 0.0 | shsolute: |0.00e+000

Minimurm element size;| 0.00e+000

Sphere mesher
Algarithm: Optimization Radius  ~
ke, terations: 500

Others

Smoothing: |HighGEDm -

Mesh unkil end Mo mesh frozen layers

[] Avaid elements with all its nodes in boundary
llov quadrilateral dominant meshes!

B“] tesh always by default: ﬂ J j - -

g1 | CIMNE

[ Accept ] [ Reset ] [ Close:




[FIEI Force points

to volume mesh

* Option to force volume tetrahedral meshes to own
points which are not topologically inside the volume.

Project: UNNAMED

ies Data Mesh Calculate Help

2| @

Unstructured
Structured
SemiStructured
Cartesian

Boundary layer

Elementtype
Mesh criteria
Reset mesh data
Draw

“& Generate mesh...

Mesh options from model

Ctrl-g

WSO W

- | % 2 |

Default

Mesh
No mesh
Default mesh

skip

No skip
Automatic skip
Skip by...

Force points to

Duplicate

Surface mesh
Yolume mesh

i

No Duplicate

A

V=

CIMNE®




SﬁFhere/ Circle mes}\er options

« Sphere/Circle mesher options in preferences
window and new generation algorithms.

Preferences
General | Graphical Meshing l Exchange | Fonts | Farmat | Grid | sphere mesher options 5|
Cuadratic bype Mai ]
() Mormal () Suadratic ) Quadratics ain EI":EI’S
Hnstructured mesher Algarithm Optimization Radius =
Surface; O RFast (5 Rsuwf O Rlump | p
Yiolume: (&) advancing Front () Delaunay () Isosurface bax. iterations 500
Aukamatic correct sizes ) )
&) Mone ) Normal () Hard bax. local iterations 2
Unstructured size transitions
0.9 Tolerance 1e-007
- . +
! L Delta position factor (0.3

Regular transition near boundary
Structured mesh Delta radius factor (0.3

Allow aukomatic structured ) )
Symmetrical structured: [ triangles [] tetrahedra kdin. radius factor 0.3

Boundary Layer Mesh .
Stretching function: |Fun|:1i0n1 (Geometric) * Growfactor |2 él Maux. radius factor 1.8
- .
[] Boundary layer mesh in separated Layver PrEprD Cess Mo DDI’DSIt'}." T
Chardal error .
] Maimum chordal error in madel, relative (%6):10.0 | absalute: 0.00e+000 Fo rDS”-'_‘y"
binimum element size:| 0.00=2+000 Fostprocess L]
Sphere mesher Chhye r|ap

Algarithm: Optimization Radius  ~
. iterations: 500

Others

Smoathing: |NDrmaI b
Mesh until end Mo mesh frozen layers
[ Awvoid elements with allits nodes in boundary

Accept ] [ Reset ] [ Close ]

Allow quadrilateral dominant meshes

Mesh always by default ﬂ J j i .77
| B CIMNE®

[ fccepk ] [ Reset ] [ Close




shing parameters

* New option to choose between meshing settings
of the model (saved the last time the model was
meshed) or the ones in meshing preferences.

Mesh genera tion 2
Enter size of elements to be generated
I v

et meshing parameters from model

[ IR ] [ Cancel

User can update the meshing preferences with the ones loaded with the

model by selecting Mesh->Mesh options from model D

CIMNE®



Other news in me: hing field

* Improvement of robustness and efficiency In
volume unstructured mesher based in advancing
front algorithm.

 Improvement in the mapping operations onto
surfaces when unstructured mesher in 3D space
(RSurf) Is used.

 Improvement in the assignment of a chordal error
global criteria to be accomplished in surface and
lines meshes (Preferences window).

CIMNE®



Other news in me: hing field

* Quadratic option inside meshing preferences,
Instead of in the Mesh menu.

« Automatic correct sizes only take care on entities
topologically connected

 Improvements in quadrilateral unstructured
mesher

« Cartesian mesher enhancements: boundary
conditions, nodes numbered by rows to access to
neighbors.

CIMNE®
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EII GiD 10 news - Visualization of results

* Results and Geometric model together:



EII GiD 10 news - Visualization of results

* Results and Geometric model together:

,
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10 news - Visualiz

ion of results

» Faster drawing using:
* OpenGL Display Lists ( OGL_useMeshObjects)

. T

OpenGL Vendor

nVIDIA
ATI
Software (Mesa 3D)
Others ( Intel, S3, ...)

extures

0 Contour Fill: 2x - 20x Speed-Up

( OGL_useCFillTexture)

0 Spheres, circles, points:

Internal texture drawing mode

Maximum number of triangles

2.000.000
1.000.000
500.000
1.000.000

Point Options/_\ ,,

" Quigk ™ Intermaltexture © Nice © Texure W Dynamicug

Faint size: Mice Detail: |2 -
¥ Size: 3

I

b i
" Result's size:

D i,

Select result. il

Fick images >>>

Apply Crriginal Close




GiD 10 news - Contour Fill

» Faster drawing using:

* Textures:
0 Contour Fill: 2x - 20x Speed-Up ( OGL_useCFillTexture)

Mapping of results to an Only a single
Image (texture) triangle is drawn

e
>
>
-

N/

>
_>I |

Texture with the : ; ;

colour scale i
CIMNE®




m]] GID 10 news - Vlsuahzatlon of results

* Results integration: Cross section used to

integrate the x-velocity

 Integral in a single step of a result:

Warning @

@) Integral value

Integral of “elocity/x' owver 'Section’ =11.424 i

Gil
* Integral across all steps:  [wr 8 o Fmremers
I@ Integral values .

Integral of “Welocityfs' over 'Section’
32821 12736
32841 13929
328.67  11.038
3zes1 1.2z
329.01 11.033
jze.21 11197
32941 10553
3z9.61  11.081
29.81 12616
330,01 11.424

| 105 =
) F r r r t Il — i T T T T T T T T T T T
: H 328 328.25 3285 328.75 329 329.25 3295 32975 330 330.25 330 pg
............ il

TR

el

* For vector results (scalar product using element s normal) cu;:usv




10 news - Visualization of results

* Loading results:
* ‘model.lst’ = List of results to be loaded
« Changing from pre to post:

Projectpostlst # may be Multiple | Merge | Single
Multiple _
Project.post.grf fenten naven 001.5.post bin

dem-fem-wavel_001.3.post.bin

* MUItlple graphs In c-Ic-ar;l—fem—wavel_001.6.post.b1'n

. dem-fem-wavel_001.7.post.bin
Same flle # graph files
dem-fem-wavel_001.FEM.fem-energy.grf
dem-fem-wavel_001.mesh-DEM.branch-vector.1l.1.grf

dem-fem-wavel_001.mesh-DEM.branch-vector.2.2.grf
dem-fem-wavel_001.mesh-DEM.dem-bonds.grf
dem-fem-wavel_001.mesh-DEM.dem-contacts.grf
dem-fem-wavel_001.mesh-DEM.elastic-energy.grf
dem-fem-wavel_001.mesh-DEM.stress-xx.grf

dem-fem-wavel_001.mesh-DEM.stress-yy.grf
dem-fem-wavel_001.node-2105.displacement.l.grf
dem-fem-wavel_001.node-2105.displacement.2.grf



mjr GiD 10 news - Visualiz%ion of results

e« Arrows in stream liInes

IVELOCITIES]
46545
l 41480
36415
31350
26285
21220
16155 (WS Seean!
11090 e e
6025.3 T
960.37

CIMNE?

Contour Fill of VELOCITIES, [VELOCITIES|. Z ‘



Giﬁ 10 news - Visualiz%ion of results

 Local axes

rrrrr

N1
g S s

CIMNE®
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GiD 10 news - Visualization of results

Polar graphs and Smith Charts

0

5

1

210

240




Other news in post-process

« Basic postprocess state saved.:
« Meshes and set: colours, styles and other properties
* View
« Result visualized except for stream lines and
Isosurfaces

e ——————————

Files View Utilities Do cuts Viewresults Options Window Help

 Status Label:
° |aS't nOde |d’ @@§|“""’“________|ﬁ =<9 & | ¥ 2 || 605931 e 4663.232 | r: Smooth t:N;|Units:m

* number of elements,
 switching render and transparency mode,
* unit support

» Creation of Delaunay meshes from nodes: ideal:»

for meshless data. e




Other news in post-process

« STL export, ascii or binary, of current meshes

* Import of xyz ASCII files:
« Compressed

» ‘free format’: x, y [, z] in same line, but any separator or
comment character can be used

s
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~ GiD 10 news - Advanced visualization

Stereoscopic mode:

N Advanced viewing settings @
ﬂlﬂ Use stereo [F] Perspective | ——»
stereo mode:  Anaglyph colors =
eye distance; Uz
[T switch eyes
eve distance mode:  scaled with the model  ~
left color rmask: red [| green [C] blue alpha
right color mask; [C] red green blue alpha
[T Use shadow
@ black (020
shadow colar: _ )
() ambient |,|J
shadow bias: Qe
| L1
[T] finer silhouette (FramebufferObject) quality:  high - I

[”] Dynamic update

Close

Advanced options window
accessible through:

Menu Bar 2> View >
Advanced Options




| 10 news - Advanc% visualization

« Stereoscopic mode:

« Both modes supported:

0 Anaglyph (Software mode): uses
colours to filter left and right images

0 Quad-buffers (Hardware mode):
uses hardware left and right buffers

« Options:
0 Eye distance: |/r separation
0 E.D. Mode: scaled / absolute
0 Colour masks for anaglyph

Advanced viewing settings

Uze stereo

stereo mode:

eve distance:

eve distance mode:

left color mask:

tight colar mask:

Uze shadow

@ black

shadow color:

Perspective | - |

Anaglyph colors -

0.020
L

switch eyes
scaled with the model
| red

green blue [¥] alpha

red |¥| green |¥| blue [V¥| alpha

0.020

ambient J]

shadow hias:

-0.002
L

finer silhouette (FramebufferObject) quality:  high

Dynamic update

-




~ GiD 10 news - Advanced visualization

Animate @

[ Results Yiew

. : ¥ Automatic Limits a?;?;jgis
« Stereoscopic mode: " Dstomaton
[ Endless
° Anima‘tions: [ From step |1 to step |
Set duration by
0 Anaglyphs: can be saved as usually @ Totel Time:[5 s
: i [ use stepwalues as scalec
0 Stereoscopic mode: allows the creation of © Delay betwsen stsps:[200 s
stereoscopic animations without hardware TR
. . 2R nUmper: Epralue. L.
guad-buffers. Special viewer, and hardware, il
required to view the animation. 0000
2= P ) - - TIFF ~ on £3

v e L ] > 0On
&

L . . .
[ Create a stereoscopic animation

Default - Resize Close
|

V=

CIMNE®




EII GiD 10 news - Advanced visualization

« Stereoscopic mode: Special colour scale: 3D anaglyphs

B | B -0.0034257
¢ -0.0089084

|} -0.0034257

¢ -0.0089084
-0.014391 -0.014391
-0.019874 -0.019874
-0.025356 -0.025356

0.023988
- 0.018505
- 0.013022
| 0.0075396

N
Pressure (Pa)
0023088
1 \'\8
0.0020569 i
-0.0034257
-0.0

- 0.018505
- 0.013022

| 0.0075396

0.0020569
-0.0034257
-0.0089084

0.014391
0.019874
-0.025356



WII GiD 10 news - Advanced visualization




« Shadows options:

 Shadow behaviour:
o Black shadows N
o Dimmed ambient light

« Shadow bias: separation between
occluder and shadow

\> Uze shadow

Y

Advanced viewing settings

Use stereo F'Efspective| - |

stereo mode: Anaglyph colors =

eve distance: D'DEDI

switch eyes
eve distance mode: scaled with the model
left color mask: |V red green blue |¥| alpha

right color mask: red [¥| green [V¥] blue [¥] alpha

@ black 0.020
shadow colar:
ambient J]
. -0.002
shadow bias:
L1
finer silhouette (FramebufferObject) quality:  high -

Dynamic update

Appby Close

* Silhouette: finer shadow contour

Advanced options window accessible

( using Framebuffer Objects)

through:
Menu Bar - View - Advanced Options
-

CIMNE®







m]I GiD 10 news - Advanced visualization

« Shadow silhouette: quality and memory usage Finer silhouette:
None

CIMNE?



m]I GiD 10 news - Advanced visualization

« Silhouette: quality and memory consumption Finer Silhoudette:
Medium

Graphics
memory
used:
4 MB

l/)\‘lv
KL
CIMNE®



m]I GiD 10 news - Advanced visualization

 Shadow silhouette: quality and memory usage  Finer Silhouetter;
Hig

Graphics
memory
used:
16 MB

(i
KL
CIMNE?®



m]I GiD 10 news - Advanced visualization

 Shadow silhouette: quality and memory usage  Finer SilhOUﬁtter;
Very hig

Graphics
memory
used:
64 MB

(i
KL
CIMNE?®



m]I GiD 10 news - Advanced visualization

 Shadow silhouette: quality and memory usage  Finer SilhOUﬁtte:
Highest

Graphics
memory
used:
256 MB

(S
KL
CIMNE®



' | 10 news - Advanc% visualization

« Shadow requirements:
« Use of shadows: OpenGL 1.4
 Dimmed ambient in shadow regions: OpenGL 1.5
 Finer silhouette: OpenGL 2.0
Graphics card memory usage:

Quality Float texture size  Graphics memory
used
Medium 1024 x 1024 4 Mbytes
High 2048 x 2048 16 Mbytes
Very high 4096 x 4096 64 Mbytes
Highest 8192 x 8192 256 Mbytes

CIMNE®



m]r GiD 10 news - Advanced visualization

« Shadows and stereo

R
P
b —— G
= T
A i e T Y
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 CompassLib inside GID, for advanced problemtype
creation (special agreement has to be made with
CompassIS for commercial purposes)

bl Gip Project: gid_lsdyna_tutorial (Isdynal.1b\lsdyna)

Files ‘View Geometry Utilities Data Mesh Calculate Help

O el | Ko i &e | ﬁ H | (;\ o % Predeterminada

) := General data
@: = EhConstraints
I - & Fixed constraints
- =@ Connections
@ - o3 Confacts
r == Joints
? L Initial conditions
Eﬂ: - X Properies
?Z X Beams
% Shalls
fa b @ solids
— 4 Dizcrete
;é-{\ b P Seathelts
}}b &0 Airbags
% 5 [ @ Materials
— '% ﬁ v fLoads
‘? @ - HiMNa self weight
e - B Punctual Load
@ @ HPressure load
o~ ~HSolid Load
S  BAPost Process ! 2

Pick LEFTMOUSE to desplace view (ESCto quif).
Pick LEFTMOUSE to desplace view (ESC to quit)

Sample use: LS-Dyna 1.1. Interface

Data is organized in a xml
tree, making easier the
edition of properties to be
atached to the geometry

CIMNE®



51D 10 news - Customization

* New Iinterfases for commercial codes developed:
- FLUENT (free)
- ABAQUS

F o e W I‘-o F&v o8 ey Faow e @

il ABAQUS Interface

Do vet / e fa 7 Comp moa /, / Sictomas
( (\ \} MD , \ ‘." ¢

/ / Pore A
4 ﬂﬁ)// Wi, ComPASSIS, ¢ om
Py,

CIMNE®



er news in customization field

« Updated to Tcl/Tk 8.5.8.

« Customization manual separated from the others
« Several new Tcl events

« Several new Tcl-GiID commands

* New bas template commands

 Hide/show all volume related menus and toolbars when
setting the global variable GidPriv(HideVolumeLevel)

« Added more Tcl packages

« Data windows enhanced with a new table widget to easily
copy/paste big data, and a XY plot can be drawn

S
/ Nl .
-

CIMNE?



D 10 news - Gen | features

e Geometry
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[Imr GiD 10 news - General features

e MAC OS X version for 32 bits available.

id  Files View Utilities Do cuts View results Options Window Help Help

fANO oo Project: langosteiraZl? 5

Cj.u.;v@r' N ’ Iﬁ = ]-"\ ;_x«%[ &> 9P o) | n: e63.257 & 4,541 650 | - Smoom 1: Ne ﬁlﬂ‘
4R, —— -
;‘i ii WA

o,
e

»
W0 e (M [Im) [T @ )

Comesr e

WO

*

STOOPLOMDU Result) I» M (

Commurymes

»=
.LJ o Select & Disg
ﬁ mat . Volumes Surtaces Cuts
- sliphabedc order
] € Narmw o 51 T im Ew b Hements
o u V VolumeMeash 4 v O B | 1 2.606.753 wtrahe
L el V Voumetdesh 14 oe @ 54,763 tevahedras
y - V VolumeMesh 0 s D 8 1 1 #9351 1evanedras
' s V VoumeMesh 14 or 1 221 658 poins
21 r V VolumaMesh 2 (= SO o 1 433658 ponnts
I : ~I V VoumeMesh 6 060 | 27,939 ponts
g = S SurfaceMesh & v O 8B B 327 288 nangles
"02 — 3 SurfaceMesh & v OBl m 3682 mangles
| > = S SurfaceMesh 7 v 0.6 B 1 3,559 mangles
.x‘ - S Surfacedesh & v OO0 & 64,262 Iriangles
.of S SurfaceMesh 9 v OB B 5,238 tranghes
SSutaceMesh10 , O B @ 1 3,108 tnangies
S SurfaceMesh 11 v OB B 28,580 lianghes
. S SurtaceMesh 12 v O 86 B 1,110 viangies
0|
Stie.  (F Sody Bound
Rencer noot!
2 3 Cding K NOne
Y ‘ B8 ,- z Condtions: ~ Nor
Contour Fil of Pressure,

l_m'rn . USNg these Amits Mn = 3 40286+ 38 Max = -3 40286+38 '. o — QP W . - g 'T
Comour Fil Pressure’ Mn = -1 33036+06, Max = 1 (S08e+08

orten: || ] 1=




GID 10 news - Gene

« Graphics setup:

Bill initial graphics configuration { OpenGL) l = | (=] |i‘3-]

Initial graphics configuration { DpenGL):
@ Fast visualization mode,

[ Models will be drawn quicker but some issues
could appear. I'm confident about rmy Graphic
Card and | wantto use its capahilities).

Safe visualization mode.

( Models will be drawn slower but the aritacts
would disappear. I'm experiencing troubles with
my Graphic Card and | wantto use OpenGL by

( This preference can ahways be accessed through
the 'Graphical' panel in the 'Ltilities—>»Freferences’
window, orwritting 'gid -openglconfig' in the

| Ok Cancel |

Preferences

]

General Graphical

OpenGL

@ Fast visualization mode.

Grid

beshing | Exchange | Fonts | Format

Safe visualization mode.

| Selection lines by software (emulateFrontBuffer).

J6.8635

Boundary lines

| Smoothed elems(deg):
ouface drawing type:
Draw quadratic elements:
Entity labels show:

-

A CURES
Mum
| GUI attenuated

The program is restarted after
accepting the preferences

Fast visualization mode: using
graphics card acceleration

Safe visualization mode: using
software graphics (CPU)
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GMed: Digital image processing platform to create
simulation data from medical images (DICOM, etc)
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H Filter 1 |m=)-----==| Filter N I—} Filter 1 |- --- - == | Filter N l—} VTK

NoiseFilter Manager | Segmentation Manager

Once the model is in GID, user can take profit of all the numerical
simulation environment, connecting to any calculation module.
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-|GMed Interface

GiD 10 new

File View Tools Window Help

‘ |
Volumetric Rendering Properties x- — , Scalar:|scalars[0]
Sice: 14

Transfer Functio[0, 170.454] x [0, 1]
P:la2.06 H:|o  5:/0.48 V:[0.64

Opacity funct[0, 170.4541x [0, 1]
P:[g3.604 V:|o.652

26, 0. 73 97 122 16

Volume Sagital| Axial| Coronary|

Coronal
Render Isosurface .-

File

Ple View Tools yindow Help

Volumetric Rendering Properties x

Transfer Function Editor

Hsy|  P21359 Hfo1

Opacity function editor [0, 4411 x10, 1

21969 V0402

Volume Sagial| Axial| Coronary

Render Isosurface

Volumetric rendering

CIMNE®



Plugins: tcl files inside the $GIDDEFAULT/plugins folder will be
automatically sourced when starting.

Zoom centered on the current cursor when using mouse wheel
Better gif pictures ( includes dithering)

Layers window enhanced

Ready for MS Windows 7 x32 and x64 bits

Added support for usb's SpaceNavigator and 3D SpaceBall in Linux

XSSO
KRR
\(‘35'?5’4’:9

TR
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